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GIS Facilities at the University of Maryland 
 

 
McKeldin Library 

ArcGIS Pro 2.3, ArcGIS 10.5 and QGIS (an open source GIS software package) are 
loaded on all public workstations in McKeldin Library, including those located in the 
McKeldin 6101 instruction laboratory. The laboratory is open to the public during 
library hours when not in use by a class or librarian. The laboratory schedule is 
posted on the window by the door and updated each week. Color printing and large 
format printing are also available in McKeldin Library. 

 
The GIS laboratory is located on the fourth floor of McKeldin Library in room 4118. 
This laboratory is available for use by faculty, staff, and students using geospatial 
methods in their research at the discretion of GIS and Spatial Data Center Staff. 
ArcGIS Pro 2.3, ArcGIS 10.5 and QGIS are installed on all computers in this 
laboratory, as well as other geospatial, image processing, and statistical packages. 

 
For a complete list of software packages available, please see our GIS 
Facilities link https://www.lib.umd.edu/gis/people-and-facilities 

 

Other Facilities 

There are other departmental (e.g., anthropology, architecture/urban planning, civil 
engineering, geographical sciences, and landscape architecture) GIS laboratories on 
campus that are restricted to faculty, staff, and students in each of those disciplines. 
Additionally, the Office of Information Technology's software licensing program 
(http://www.oit.umd.edu/slic) offers ArcGIS at special/reduced rates for faculty and 
staff at the University of Maryland. 

 
 

https://www.lib.umd.edu/gis/people-and-facilities
http://www.oit.umd.edu/slic
http://www.oit.umd.edu/slic
http://www.oit.umd.edu/slic


 

Data Types for GIS 
 

 
Vector and Raster (or Grid) are the two types of data used in a GIS. 

 
 
Data Types 

 
● Vector - uses geometric objects – ● Grid (Raster) - is composed of a 

points, lines and polygons – 
to represent real features on 
the earth’s surface such as 
light poles, roads and 
buildings. Ideal for discrete 
themes with definite 
boundaries. 

continuous grid cells that 
represents a portion of the 
earth’s surface. Ideal for 
continuous themes where 
there is lots of change. 

 
 
 
 
Graphic Source: 
Crown, Inc. 

(http://www.ordsvy.gov.uk/gis-
files/stage1/) 

Remember: 
either can be used, 
but one or the 
other will be 
better suited to 
certain kinds of 
data. 

 
 

http://www.ordsvy.gov.uk/gis-files/stage1/)
http://www.ordsvy.gov.uk/gis-files/stage1/)
http://www.ordsvy.gov.uk/gis-files/stage1/)


 

 

 

Vector Data Model 
Source: Kenneth E. Foote and Donald J. Huebner, The 

Geographer's Craft Project, Department of Geography, 
University of Texas at Austin. 

 

Grid (Raster) Data Model 
 

  



 

Data Sources for GIS 
 

 
● Digitized and Scanned Maps 
● Databases, spreadsheets (tables) 

■ dBASE III and dBASE IV (.dbf) 
■ Microsoft Access (.mdb) 
■ Microsoft Excel (.xls) 
■ Tab-delimited text (.txt) 
■ Comma-delimited text (.csv) 
■ INFO files 

● Global Positioning Systems 
● Field Sampling 
● Remote Sensing and Aerial Photography 

 
Spatial vs. Non-Spatial data 

 

 

ArcMap needs data to have a spatial component in order for it to be analyzed 
and put to its best use. This means the data has to have some correlation to a 
location on the Earth. That might be a place name, a specific code that relates 
to a place (such as a ZIP code or a FIPS code, or a street address), or a set of 
latitude/longitude coordinates. 

 
How to convert non-spatial data to spatial data 

 

• Import Tabular Data → Joining/relating Tables 
 

• XY Event Theme 
 

• Address Event Theme or Geocoding 

For raster (grid) data, if an image does not have embedded spatial 
information, you will have to “georeference” it. There are several ways to do 
this: 

 
- You overlay the image and point out several places where it 

corresponds to known locations – then the computer can adjust 
the image to fit correctly. 

- You tell the computer a set of coordinates which are where the 
top left corner of the image begins and what the definition is of 
the size of each cell (ex: 10x10 meters) 

 
 
 



 

 

Joining and Relating Tables 
Imported tables of outside or stand- alone data can be used in ArcMap by 
joining or relating them to an existing shapefile and its attribute table. 

 
• Tables may be joined by a common field (a column that contains the same 

information). 
 

• One of the columns should contain unique values (only one occurrence of each 
value). 

 
• The data in the field must be an exact match (no spelling errors). 

 
• The data in the field must be of the same type (number, character string, 

Boolean, or date). 
 
Joining a table appends attributes from the new table to an existing one 
based on a common field. 

 
Through a common field, known as a key, you can associate records in one table with 
records in another table. 

 
The relationship is one-to-one or many-to-one. 

 
Relating a table defines a relationship between two tables, also based on a 
common field, but does not append the attributes—instead, you can access the 
new data when necessary. 

 
The relationship is one-to-many or many-to-many. 

 
Relates can help you discover specific information within your data. For example, if you 
select a building, you can find all the tenants that occupy that building. Similarly, if you 
select a tenant, you can find what building it resides in (or several buildings, in the case 
of a chain of stores in multiple shopping centers—a many-to-many relationship). 

 
Unlike joining tables, relating tables simply defines a relationship between two 
tables. The associated data isn't appended to the layer's attribute table like it is with 
a join. Instead, you can access the related data through selected features or records 
in your layer or table. 

 
 



 

 

Relationships between Tables 

When importing new tabular information for inclusion in your map, it’s important 
to decide what relationship you want to establish between the common identifiers 
in each table. 
These relationships include: one-to-one, many-to-one, one-to-many, and many-to-many. 

 
One-to-one relationships match one identifier in the first table with the shared 
one in the second. In this case, Allegany (county) in Table A will be matched 
with Allegany in Table B. 

 

 

Many-to- one relationships match possible multiple records in the first 
table with one record in the second. Table C below shows multiple 
purchases with information about the store, transaction number, and date 
of purchase. Table D shows the identifying information about the store and 
acts as a lookup table for musical stores. In this example, the match is from 
store ID in Table C to store ID in Table D. 

 

Table C 
 

Store Transaction Date 
ID # 
T456 001 01/15/06 

T456 002 03/21/06 
M541 003 06/28/06 

 
Joining Tables 

Table D 
 

Store ID Name City 

T456 Tom’s Music Store Greenbelt 
M541 Music Plus Baltimore 
L655 Larry’s Guitars Fallston 

You may find that you need to access information from several different tables. For 
example, a project involving homeowners might require a tax assessment table, a 
demographic table, and a real estate transactions table. All that is required to join 
tables is that they have a field (column) that is common (contains the same 
information) to both tables. This field is called the common identifier. For example, if 
you have a table that lists house address and assessed value and another table that lists 
house address and owner’s name, you could join the tables based on house address 
and create a virtual table that lists house address, owner’s name, and assessed value.



 

It is important to remember that the information in the common field must match 
exactly. For example, if you are matching on the field County Name, “Prince George’s” will 
not match with “Prince Georges,” “Prince George’s County” or “Prince George’s Co.” 
because the characters in the field are not exactly the same. Additionally, the field must 
contain the same type of data, character string or numerical. 
 
 

Numerical data consists of numbers and may contain decimals or a negative sign. The 
computer knows that it can perform mathematical functions on numerical data. On the 
other hand, a character string may contain letters, letters and numbers, or only 
numbers. However, the computer cannot perform mathematical functions on data in a 
character string, even if it consists solely of number symbols. A character string field 
and a numerical field cannot be joined even if the symbols in the field appear the same. 

 
An example of this can occur when working with census data. A number designates a 
census tract. However, a census tract is often represented in a database as a character 
string composed of numerical symbols because the number represents a name, not a 
quantity. This prevents people from attempting mathematical operations on the name 
of the census tract. After all, you wouldn’t expect to multiply Montgomery County by 
Prince George’s County and get a sensible result. When you import a text file into the 
GIS, it may interpret the numbers in the census tract name column to be a numerical 
string. If this were to happen, you can’t join the two tables because, although the data 
appears to be the same, one is a character string and the other is numerical. You would 
need to manipulate the table data outside of the GIS before importing it to ensure that 
it is read as the correct form of data. 

 
Relating Tables 

 
There are times when you want information associated with a particular layer, but 
do not want to join the information to it. Joining tables establishes a one-to-one 
or many-to-one relationship. Relating tables, however, allows you to create a 
one- to-many or many-to- many relationship. For instance, you may want to 
include information on the many organizations in one county. Instead of creating 
a traditional relationship, relating tables allows you to access supplementary 
information about the organizations. 

 
In One-to-many relationships one record (Company) in Table E is potentially 
matched with many records in Table F. 

 

 



 

In Many-to-many relationships, multiple records from each table can correspond. 

 
When relating tables, it is best to relate a table that is in .dbf format 
rather than delimited text. 

 
 



 

Exercise: Mapping Locations by (x,y) Coordinates 
 

 
ArcMap allows you to add XY data in the form of a pair of coordinates, such as 
longitude and latitude, within a table. We can import tables of information that 
contain coordinate data, such as that captured from a global positioning system 
(GPS), and convert them to a point coverage by using the latitude and longitude to 
represent the X and Y values in a Cartesian coordinate system. The data included in 
the table can then be turned into a layer. 

 
To do so requires a dBASE (extension .dbf) or tab or comma-delimited text file with 
separate columns for the latitude and longitude in order for ArcMap to plot the 
points. GPS is used in fieldwork for surveying; tracking animal movements; locating 
sampling points, crimes or accidents; etc. Locations can be recorded precisely and 
accurately using the GPS and incorporated with other data, and then imported into 
the GIS for mapping, analysis, and visual display. We will be working through an 
example with stream sampling data. 

 
Note: You can bring in an Excel spreadsheet that has X,Y coordinates and display it 
successfully in ArcMap, but you cannot select, query, or edit the features in the 
resulting layer because there is not an object ID field. It is usually best to turn the 
spreadsheet into a dbf file (right click > Data > Export). 

 
Creating a Table with XY Coordinates 

 
XY tables are an easy, accurate, and quick way to import data into a GIS. All that is 
required is some form of tabular data in which two of the columns contain location 
information (longitude and latitude) in decimal degree format. For this exercise we 
will use real-time stream flow data that is posted by the United States Geological 
Survey (USGS) on the Internet to create a sample point location theme. We will do this 
by importing into ArcMap a dBASE file (.dbf) that contains the latitude and longitude 
of stream sampling points in Maryland and use this information to create a point 
theme that maps the location of each sampling point. The information about each 
sampling point will be stored in the attribute table for the new theme. 

 

Importing the Data 
To begin, navigate to the GIS workshop page 
https://www.lib.umd.edu/gis/workshops. Scroll down and look for the GIS Data 
Management workshop materials. Click on Data under Materials. Click on the 
Download button you see on the top right corner. Unzip and save the files in 
Downloads. Note the Geocoding_data folder within your Data folder. This will be 
used for geocoding exercises. 

 
For this exercise, we created a dBASE file (.dbf) from textual data downloaded from the 
USGS’s list of all the stream gauges in the United States. For more information on 
stream gauges take a look at http://waterdata.usgs.gov/nwis/rt. 

 

http://www.lib.umd.edu/gis/workshops
http://waterdata.usgs.gov/nwis/rt
http://waterdata.usgs.gov/nwis/rt


 

 
Beginning with a Blank Project

1. Search for ArcGIS Pro in your Windows explorer:    
 

Upon opening ArcMap you may see the following startup window: 
 

 
 
 
This is a new feature with ArcGIS Pro 
software that allows you to create 
projects. Each project contains its own 
geodatabase where you files will be 
stored.  Since we’re just beginning, we are 
going to create a new project. Click on 
Map.aptx to begin. Give your project an 
name (like ‘Data Management’) and click 
Okay. 
 

ArcGIS Pro stores each project in 
the  C:\Documents\ArcGIS\Projects 
folder.  If you do not specify a 
location when saving your work, 
this is the location to which it will 
be saved. 

 
 
Now you will be in a new, blank map 
document in ArcGIS Pro. 

 



 

 
 

1. Click on the ‘Add Data’ icon.  

2. Navigate to 
C:\USERS\”YourDirectoryID”\DOWNLOADS\DATA\ 
and add ‘mdcounties.shp’ and ‘Water.dbf’. 

 
Let’s take a look at the table. In the Table of Contents area, right click on ‘Water.dbf’ > 
‘Open’. 

 
The table contains the water gauge name, state, and information about water flow. 
Notice that the coordinates (in decimal degrees) are contained in two columns–one for 
latitude and one for longitude. The fields must be numeric. Columns that are left 
justified are character strings and columns that are right justified contain numerical 
data that you can perform mathematical functions on. 
 

 

 
3. Close the table. 

 

Mapping the Coordinates 
 
Now let’s map the newly added data. 

 
Right click on the ‘Water’ table layer and choose ‘Display XY Data’. The ‘Make XY 
Event Layer’ window will open. 

 
 



 

In the ‘XY Table’ drop- down box ‘Water’ should be listed. In addition, the ‘X Field:’ 
should be ‘LONDD’ and the ‘Y field:’ should be ‘LATDD.’ If these are not included, 
change them as indicated below. 

 
Click on the globe next to the Spatial Reference box. In the Spatial Reference 
Properties window, navigate to Geographic Coordinate Systems > North America > 
NAD 1983. Click OK. The new coordinate system should appear. 
 

 
 
Click Run in the Display XY Data. 

 
 
You should see the layer ‘Water_Layer’ added to the table of contents. The points 
should draw overtop of the Maryland data. If the points do not draw over the Maryland 
make sure the latitude and longitude were in the correct fields. If you reverse them, 
the points will be located somewhere around Australia. 

 
 
 
 
 
 
 
 
 
 
 

 



 

TECHTALK 

Before importation it is important to make sure that all the records accurately reflect 
the spatial locations of the information. One of the most common mistakes is to not include a negative 
symbol for western and southern hemisphere longitude or latitude records. The world is divided into two 
east-west hemispheres and two north-south hemispheres. Each is assigned either a positive or negative 
value for latitude (southern is negative and northern is positive) and longitude (eastern is positive and 
western is negative). 

 

Explore the data by zooming in and out. Identify some of the points. Zoom back to 
the full extent. 
 
Now we will convert ‘xy-event’ to a Shape File 
 
The layer ‘Water_Layer’ added to the table of contents is not a permanent file, 
meaning it will disappear when ArcMap is closed. 

 
To create a permanent file, 

 
1.  Right click on ‘Water_Layer’ > Data > Export Features. 

 
 
 
 
 
 
 
 



 

3. Give your new file a name under ‘Output Feature Class” If asked if you 
would like to add the exported data to the map as a layer, click Yes. 

4. Click Run 
 
 
 
 

Exercise: Adding, Editing, Joining, and Relating Tables 
 

 
There are a few ways to use tables in ArcGIS. You can add tabular data to a project, 
connect to a database, or create a new table to which you can add data from within 
ArcCatalog. In this tutorial we will add tabular data that we have stored in a separate 
file in the computer, as well as edit, join, and relate it. 

 
Adding a table 

 
We will be adding an existing table with race data (Race.dbf) and joining it to a 
MD county shapefile. Let’s add the shapefile and the table to ArcMap now. 

 
1. On the Insert tab, click the button for ‘New Map’. This allows us to 

create a new data frame to work with.  
 

2. Add ‘Race.dbf’ to ArcGIS Pro by clicking on the Add Data icon 
3. In the table of contents in ArcGIS Pro, right click on ‘Race’ and click on ‘Open’ 
 

You can see that ArcGIS Pro has read the information in the file and placed it in the 
table so the information is displayed in neat columns. Columns that are left justified 
are character strings and columns that are right justified contain numerical data on 
which you can perform mathematical functions. 

 

3. Close the Race table. 



 

4. Navigate to C:\USERS\”YourDirectoryID”\DOWNLOADS\DATA\ 
and add ‘mdcounties.shp’. 

 

We will be joining the ‘Race.dbf’ table to the ‘mdcounties’ attribute table. Take a 
look at the attribute tables of each to see if there is a common field that can be 
used to make a join. 

 
 

Now let’s join the tables together. 
 

1. Right click on ‘mdcounties’ to open the 
context menu. 

2. Click on ‘Joins and Relates’ 
3. Click on ‘Add Join…’ 

 
 
 

The Join Data window will open. 
 

 
 
 
5. In box 2, choose ‘NAME’. This is the column in the ‘mdcounties’ layer that we 
are matching to the table. 
 6. In box 3, choose ‘Race’. This is the table we want to join. 
 
7. In box 4, choose ‘GEOGRAPHY’. This is telling the ArcGIS what column 
in the table (Race) we are matching to the layer. 
 
 
 
8. Click Run 
 
 
 
 
 
 
 
 
 
 
 
 
 

Now let’s check the ‘mdcounties’ layer to see if the new information has 



 

been added to the attribute table. 
 

1. Right click on ‘mdcounties’ to open the context menu. 
2. Scroll down to ‘Open attribute table.’ 
3. Scroll to the very end of the attribute table to see if the new 

information has been added 
4. Take a close look at the attribute table. If you have <Null> values in 

some of the Geography fields, your join was not complete.
 

 

 
TECHTALK 

Are there rows that have “<Null>” in them? This will appear anytime you don’t have 
information for every row in the layer or when the data in the column you are using 
to join (in the table) does not exactly match the column in the attribute table. 

 

 

Common problems that can cause <Null> values in a join: 
 

• Spelling is not in agreement 
 

• Apostrophes or other punctuation marks are not in agreement (ex: 
Prince George’s in one table, Prince Georges in another) 

 
• Case sensitivity is not in agreement 

When a join is unsuccessful, you will need to unjoin, clean up data in one 
table or the other so that they are in agreement, and rejoin. 

 
To unjoin, right click on ‘mdcounties’ > ‘Joins and Relates’ > ‘Remove Join(s)’ > ‘Rac

 



 

Editing Tables 
 
If there are small errors in your table that are causing <null> values and an 
unsuccessful join, you may want to edit the table. If there are large-scale changes to 
be made, you will do better to edit the table outside of ArcGIS and then bring it back 
in. Please note that you cannot edit an Excel spreadsheet table in ArcGIS. Before we 
can edit tables, we first need to activate the “Editor toolbar.” To turn the toolbar on: 

 
1. Open the ‘Race’ table.  

2. Double click on a field in the table to make 
changes (Remove any apostrophes that may 
appear in a county’s name). 

3. Once you have made the necessary changes, go 
to the Edit tab and click Save 

4. Close the table.  
 
Repeat the joining process. 

 
1. Right click on ‘mdcounties’ to open the context menu. 
2. Click on ‘Joins and Relates’ 
3. Click on ‘Join…’ 
4. When the join window opens, keep the default ‘Join attributes from a table’ in 

the top box. 
5. In box 2, choose ‘NAME’. 
6. In box 3, choose ‘Race’. 
7. In box 4, choose ‘GEOGRAPHY’. 
8. Click ‘Run’. 

 
You may be asked if you wish to index this file. If so, select ‘Yes’. 

 
 



 

Now our tables should be joined. Open the attribute table again for ‘mdcounties’ to 
check if it joined correctly. 

 
Because we have joined this new information to our attribute table, we can make 
maps with it. Practice making color, dot density, or chart maps with the new race data. 

 
Relating Tables 

 
In our case, we are going to relate a table showing multicultural resources in 
Montgomery County. Although Montgomery County is one of the counties in our 
attribute table, we could not have conveniently listed more than one resource to 
the record we already joined. 

 
1. Select the ‘Add Data’ button.  
2. Change directories until you find 

C:\USERS\”YourDirectoryID”\DOWNLOADS\DATA\. 
3. Click on ‘Montgomery_race.dbf’. 
4. Click the ‘Add’ button. 
5. Open the table. Right click on ‘Montgomery_race.dbf’ and click ‘Open’. 

 
 
When you are finished looking at the attribute 
table close it. 

We’d like this new table to be 
associated with our ‘mdcounties’ 
layer. 

 
1. Right-click on ‘mdcounties.’ 
2. Click on ‘Joins and Relates.’ 
3. Click on ‘ Add Relate.’ 

The Relate window will open. 
 
 
 
 
 
 



 

 
        3. Using the Input Relate Field drop down box, scroll down and select ‘NAME’.    
We are saying that the data in our table is related to the counties.
 

4. In the next drop down box, select ‘Montgomery_race’. This is our table 
that we are relating. 

 
5. In the last drop down box, choose ‘COUNTY’. This tells ArcMap which 

field in the ‘Montgomery_race’ table should be related to the ‘NAME’ 
field in the ‘mdcounties’ layer. 

 
6. Lastly, name the Relate “Montgomery multicultural resources” and click ‘Run.’ 

 
Let’s check if the relate was correctly completed. 

 
1. Click on the Data tab 
2. In the Relationship block, click Related Data → Montgomery multicultural 

resources 
 

 
This opens the table we just related. Minimize the attribute table to view the new table. 

 
By relating tables we associate the information in one table with another but do not 
physically join the information into one table. You can view the association between 
tables by selecting a row in the attribute table of a layer file and then from the 
attribute table > Options icon > Related tables. The rows that are related will also be 
selected (in bright blue). 

 
 
 



 

Exercise: 
Geocoding 

Geocoding is a process that allows you to match location data that has no coordinates to 
an established reference database, and thereby create point features and make the 
original data mappable. It is commonly used for data containing addresses, and is a 
powerful tool in the GIS arsenal. 

 
Or 

 
Geocoding is the process of converting addresses (like a street address) into 
geographic coordinates (like latitude and longitude), which you can use to place 
markers on a map, or position the map. 

What you need in order to geocode 
 

 

 
 

 
 

 
Where do I get Reference Data? 

 
● With ArcGIS Pro, you may not need reference data—the incorporated 

basemap layer can provide this streets data. 
 

● A common source is TIGER files, published by the U.S. Census Bureau. 
 

● Reference data may also be called an address dictionary. Its attribute table 
will break down an address into individual components. You will often use a 
streets layer for reference data.  The table might look something like this: 

 
L_F_AD 
D 

L_T_AD 
D 

R_F_AD 
D 

R_T_AD 
D 

PREFI 
X 

NAME TYP 
E 

SUFFI 
X 

ZIPL ZIPR 

4300 4398 4301 4399 E Graha 
m 

Way N 2074 
2 

2074 
0 

 

Location Data 
(a table with location information 

such as: address, ZIP code, city name) 

 

Reference Data 
(what you are going to match 

 

Address Locator 
(what you use to make the 

 



 

Where do I get an Address Locator? 
 

● ArcGIS has address locators incorporated directly into the software. 
 

● ESRI has some address locators available for free to subscribers, and they cover 
the world and the U.S. This help page gives you a little more detail on geocoding 
vocabulary and address locators: 
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Essential_geoc
oding_v ocabulary/002500000004000000/ 

 

● You can create your own. 
 

● Look on the Internet. Here’s a useful list compiled by Texas A&M 
University: 
https://geoservices.tamu.edu/Services/Geocode/About/GeocoderLi
st.aspx 

 
 

What is happening when I geocode? 
 

● ArcMap looks at a specified field in your Location Data. For example, you may 
have a field “Address” with the value “4315 East Graham Way North”. The 
program will parse the data so that it matches the format found in the 
Reference Data. Using the example provided above, the address would be 
parsed into: 

 
● Next, the program compares the Location Data to the Reference Data, and 

when matches are found an interpolation is performed to locate and assign 
real-world x,y coordinates (latitude and longitude) to the address. 

● ArcMap assigns each address match a score depending on the exactness, then 
creates a geocoded layer with the newly assigned coordinates, and the 
information about those points that was stored in the Location Data now 
appearing in the geocoded layer’s attribute table. 

 
 

 

 

 

 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html%23/Essential_geocoding_vocabulary/002500000004000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html%23/Essential_geocoding_vocabulary/002500000004000000/
https://geoservices.tamu.edu/Services/Geocode/About/GeocoderList.aspx
https://geoservices.tamu.edu/Services/Geocode/About/GeocoderList.aspx


 

Exercise:  Mapping Lincoln, Nebraska Places 

For this exercise, we have a table with a number of locations in Lincoln, Nebraska. For 
each location we have a name and address.  We’d like to map these out. 

 
Adding Data 

 
Create a new map tab in your project. You can rename your maps tabs by Double CLicking 

the Map  layer in the Contents pane and changing the name. Rename this one 
“Geocoding”. 

   Click on Add Data and add the following layers from the Geocoding_data folder: 
 

1) CustomerInfo.dbf (this is your location data) 
2) Lincoln.shp and Lincoln_Downtown.shp (this is your reference data) 
3) Streets.shp (this is the streets on which our addresses will be located) 

 
Geocoding 

 
In the Geoprocessing pane, search for ‘Geocode Addresses’. 

You will need to login to ArcGIS online in order to use this 
geocoder. Click where it says ‘Not Signed In’ on the top right of the 
screen. 
 
Use these credentials below:  
Username:geocoder4 
Password: GISintro2018 
 
For the Input table, choose ‘Customer Info’ 
Choose “ESRI World Geocoder” as the Input 
Address Locator– this is the address locator 
provided by ESRI. 

 
Because the address is stored in a singular 
column, we must change to Address Input Field to 
“Single Field”. Select “ADDRESS” as the single line 
field from the dropdown menu. This is letting you 
know what fields from the address locator will 
map to which field from the table with your 
addresses when the comparison is made. 

 
When you geocode, the output will be a new 
shapefile – you should name it and save it to 
your geodatabase.  

 
 
 
 

Click Run to complete the geocoding process. You will see a process window and then a 



 

result box letting you know how successful the matching process was. 
 

 
 

Click Close. You will see that there is a new point layer called Geocoding Result in your map, 
with a point for each entry in the spreadsheet. Do they seem to be in the right places? 

 
Also, take a look at the attribute table of your new geocoded results point layer. You will see 
that there are some new fields such as STATUS (with M, T, or U for matched, tied, or 
unmatched) and SCORE (how accurate was the match?). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Publish from ArcGIS Pro to ArcGIS Online 
Note: You must have an ArcGIS Online Organization account to be able to 
publish. 
 
From ArcGIS Pro, you can publish a feature layer to be hosted on ArcGIS 
Online. When you publish a hosted feature layer, data is copied from your 
data source to ArcGIS Online. The published hosted feature layer 
references the data in ArcGIS Online, not the data source. 

Note: 
If the layers in ArcGIS Pro have definition queries applied to them, ArcGIS 
applies the definition queries to the published hosted feature layer. 
However, all data is uploaded to ArcGIS Online. If you want only a subset of 
the data to be published to and stored in ArcGIS Online, you must export 
the subset of the data to another feature class and publish that. 
An Internet connection is required to perform these steps. The speed and 
bandwidth of your connection affect the time it takes to publish. 
By default, editing is not enabled on hosted feature layers, but you can 
enable editing from ArcGIS Pro when you initially publish or overwrite an 
existing feature layer. 

Tip: 
● Web browsers cannot display some of the more complex cartographic 

symbols used when authoring the map in ArcMap. Most symbol types 
are available, but some symbols may be downgraded when you 
publish them. See Author feature services in the ArcGIS Server help 
for more details about what symbols are supported. Make any 
required changes to your map symbology prior to publishing. 

● To reproject the data used by the hosted feature layer, either apply a 
geographic transformationto the data when publishing or add a 
coordinate system transformation to your map before publishing. 

Web browsers cannot display some of the more complex cartographic 
symbols you might have originally used when you authored the map. Most 
symbol types are available but, in some cases, the symbols may be 
downgraded when you publish them. See Author feature services in the 
ArcGIS Server help for details about what symbols are supported, and make 
any required changes to your map symbology prior to publishing. 

1. To publish your feature layer, do one of the following: 
○ Select the layer in the Contents pane. Right-click the selection set 

http://enterprise.arcgis.com/en/server/latest/publish-services/windows/author-feature-services.htm
http://pro.arcgis.com/en/pro-app/tool-reference/environment-settings/geographic-transformations.htm
http://pro.arcgis.com/en/pro-app/help/mapping/properties/geographic-coordinate-system-transformation.htm#ESRI_SECTION1_0769B2CAE1A3484189D8EB11474ADCE6
http://pro.arcgis.com/en/pro-app/help/mapping/properties/geographic-coordinate-system-transformation.htm#ESRI_SECTION1_0769B2CAE1A3484189D8EB11474ADCE6
http://enterprise.arcgis.com/en/server/latest/publish-services/windows/author-feature-services.htm


 

and click Share As Web Layer. When you publish selected layers, 
only a hosted feature layer is created on ArcGIS Online. 

○ Tip: If the Share As Web Layer menu option is not active, it could be 
due to one of the following: 

■ You are not signed in to ArcGIS Online with an organizational 
account. 

■ The account you signed in with does not have privileges to 
publish hosted feature layers. 

■ You're trying to publish a multipatch layer, which is not 
supported. 

○ To share the map and publish all of its layers, click Web Map in the 
Share As group of the Share tab. When you share a map using 
ArcGIS Pro, the map layers are also published as hosted layers. 
 

2. Type a name for the feature layer. The layer is saved to 
My Content by default. You can save to a folder in My 
Content by either typing the folder name or browsing to 
an existing folder. 
 

3. Accept the default Layer Type option of Features. 
 

4. Provide a summary and tags for the feature layer. 
 

5. Specify who can access the feature layer. By default, 
all layers you publish are shared only to your personal 
workspace in your organization (My Content). Your 
content is inaccessible to others until you share it with 
one or more of the following: 

○ The name of your organization—This option is 
available when you are signed in with an 
organizational account. Selecting this option 
makes the layer accessible to all authenticated 
users in the organization. 

○ Everyone—Selecting this option makes the layer 
available to the public. 

○ Groups—You can share the layer with members 
of groups to which you belong. 
 

6. By default, editing is not enabled on the feature layer, it cannot be taken 
offline, and the data it contains cannot be exported. To allow others to 
perform these operations on your feature layer, click the Configuration tab, 
click the Configure Layers button , and check the box next to the 
operations you want to allow: 

○ Enable Editing—This operation enables members of your 
organization who have edit privileges to add, update, or delete 
features in your hosted feature layer. 

○ Enable Sync—This allows people to download maps containing the 
hosted feature layer, edit the data, and synchronize their changes 



 

back to the hosted feature layer. It also allows you to share the 
hosted feature layer in a distributed collaboration. 

○ Export Data—Enabling this operation allows other members to 
export data from the hosted feature layer. The hosted feature layer 
owner and organization administrator can always export data from a 
hosted feature layer even if this operation is not enabled. 
 

7. Click the Content tab to confirm your feature layer includes the data layers 
you intended. 
 

8. Click Analyze to check for any errors or issues. 
 

9. If any issues are discovered, they are listed on the Messages tab. Right-
click each message to get more information, read help for the error or 
warning, and access suggested fixes. You must fix the errors before you 
can publish. You have the option to fix the warnings to further improve the 
performance and appearance of your hosted feature layer. 
 

10. Once you've fixed the errors and, optionally, any warnings, click Publish, 
and wait for they layer to be successfully published.  
 
Note:Your data is copied to ArcGIS Online at this point. The size of the data 
and your Internet connection speed and bandwidth affect the time it takes to 
publish. 
 

11. Now log in to your ArcGIS Online Account 

 
12. Click the “Content” tab. 

 
13. You will now see all of your published layers, including the one you just 

published.  
 

14. Click on the layer you have just published, which will open the item 
overview.  
 

15. Now click “Open in Map Viewer” , to see your map on ArcGIS online. 

https://doc.arcgis.com/en/arcgis-online/share-maps/about-sharing-content-to-a-collaboration.htm
https://doc.arcgis.com/en/arcgis-online/manage-data/use-hosted-layers.htm#GUID-47A1D795-B330-45D7-89F7-9203A99E6924


 

 
16. Your layer has now been published online, where it can be shared and 

analyzed further. 

 

 

 
 
 
 
 
 

Self-Directed Exercises: Crime, Census, Food Atlas 
 

In the next portion of the workshop, you will independently download data in 
both shapefile and table formats, then join the table to the shapefile. Finally, you 
will make a color map with the resulting joined data. 



 

 
You may choose to do one exercise based on the topic that interests you the 
most, or you may try all three! 

 
If you want to try to do the exercise entirely on your own, go right ahead. 
If you get stuck, there are cheat sheets on the following pages for 
reference. 

 
General hints – READ BEFORE BEGINNING! 

 
• When downloading shapefiles, they will generally consist of a zip file 

(remember how a shapefile is composed of multiple files?). You will 
need to download the zip file, then unzip it and extract the files to the 
DATA folder in your DOWNLOADS, or to your own storage device. 

 
• You will need a field in the shapefile that can match up to a 

field in the table you download in order for them to join 
properly. 

 
• You will need a one-to-one or many-to-one relationship to make a join. 1-1 is 

best. 
 

• When you are looking at an outside table and considering if you can 
bring it into ArcGIS, remember that you may have to do a lot of 
cleaning up of formatting and you may need to transpose rows and 
columns for the outside table and the shapefile’s attribute table to 
match. This can be labor intensive and time consuming! 

 
• ArcGIS will usually not accept spaces in field names for standalone tables. 

 
• Remember to be very careful about where you save things that you 

download—it is easy to lose track of them. Please save everything 
you download to the DATA folder in the DOWNLOADS folder. 

 
• When you’ve downloaded an Excel spreadsheet, ArcGIS may 

present you with a list when you try to add the table. This reflects 
the various workbooks in an Excel spreadsheet—just choose the 
first one in the list. 

 
• You may need to format the cells in an Excel spreadsheet to “general”. 

 
• Sometimes the metadata for downloaded data is not along with it, but 

in a separate file or on a website. 



 

• NOTE: These instructions are for downloads using the Firefox web browser. The 
process may be slightly different if using Internet Explorer. Use Firefox to avoid 
confusion. 

 

If you want to keep going or try something else on your own, this guide to GIS 
Data and Websites may help you find some data to experiment with: 
http://lib.guides.umd.edu/gisdata 

 
 
 

http://lib.guides.umd.edu/gisdata


 

 
Crime 

• Download a shapefile containing boundaries for all U.S. states from the 
following website: 
o https://www.census.gov/geo/maps-data/data/tiger-line.html    (go to the 

2017 TIGER/Line shapefiles main page, then click on “Download” select 
Web Interfaces and pick “States (and equivalent)“ from dropdown menu 
and submit.) 

 

• Download a table from the FBI’s Uniform Crime Reports Data Tool: 
https://ucr.fbi.gov/. Clean it up so that it can match the attribute table of 
your U.S. states shapefile and identify a common field. 

 

o Hint: does your table contain one row per state, and are the states 
rows or columns? They should match the attribute table you want to 
join to. Is the first row of the table the fields that you want to be the 
column headings? 

 

o Hint #2: One Year of Data – choose all states – choose a variable 

should give you a workable table. 
 

• Join the crime table to the U.S. states shapefile. 
 

• Once the tables are joined, make a color map showing some crime numbers 
mapped for the entire U.S. 

 

Census 

• Download a shapefile containing boundaries for all U.S. states from the 
following website: 
o https://www.census.gov/geo/maps-data/data/tiger-line.html    (go to the 

2015 
 

TIGER/Line shapefiles main page, then click on “Download” select Web 
Interfaces and pick “States (and equivalent)“ from dropdown menu and 
submit.) 

 

• Download a table from American Factfinder: http://factfinder2.census.gov/. 
Use the Advanced Search. Clean it up so that it can match the attribute table of 
your U.S. states shapefile and identify a common field. 

 

https://www.census.gov/geo/maps-data/data/tiger-line.html
https://ucr.fbi.gov/
https://ucr.fbi.gov/
https://www.census.gov/geo/maps-data/data/tiger-line.html
http://factfinder2.census.gov/
http://factfinder2.census.gov/


 

o Hint: choose your geography first (all U.S. states) 
o Hint: The “Housing Units” (H1) table from the 2010 SF1 summary file 

might be a good table to try out…you want a table that has one row 
per state, and for the states to be rows, not columns.

 

If you need to, use “modify table” to transpose rows and columns. 

• Join the census table to the U.S. states shapefile. 
 

• Once the tables are joined, make a color map showing some one of the 
number fields from the newly added table mapped for the entire U.S. 

 

Food Environment Atlas 

• Download a shapefile with U.S. counties from the census website: 
o https://www.census.gov/geo/maps-data/data/tiger-line.html    (go to the 

2015 
 

TIGER/Line shapefiles main page, then click on “Download” select 
Web Interfaces and pick “Counties (and equivalent)“ from 
dropdown menu and submit.) 

 

• Download the spreadsheet containing compiled data from the Food Environment 
Atlas: 
http://www.ers.usda.gov/data-products/food-environment-atlas.aspx (Go to 
“Data Access and Documentation Downloads” and download the Excel data file 
for the current version) 

 

• Join one of the worksheets from the spreadsheet to the attribute table of your 
counties shapefile. 

 

o Hint: You need to read the Variable List worksheet to identify the 

fields in the rest of the spreadsheet. 
 

o Hint #2: The common attribute for the join is not a name, but a number… 

• Once the tables are joined, make a color map showing a new variable from 
the Food Environment Atlas data.

SPOILER ALERT – DON’T LOOK AT THESE CHEAT SHEETS AHEAD OF TIME 
 

Crime Exercise – Cheat Sheet 

https://www.census.gov/geo/maps-data/data/tiger-line.html
http://www.ers.usda.gov/data-products/food-environment-atlas.aspx


 

To download a shapefile containing all U.S. States: 

1. Go to the following link to download a shapefile with boundaries for all U.S. 
states: 

https://www.census.gov/geo/maps-
data/data/tiger-line.html 

2. Click on 2009 TIGER/Line Shapefiles Main page, then click on 
“Download Shapefiles”. Check off the box for “State and Equivalent 
(Current) and click on “Download Selected Files” 

 

 
 

1. In your downloads, unzip the folder that was just downloaded 
(using Peazip). 

Be sure to extract the files to the DATA folder in the DOWNLOADS folder. 
 
 
 
2. Preview your extracted shapefile in ArcMap to see if everything looks correct. It 

will probably be called tl_2009_us_state.shp (it looks small within the display 
because it includes the Northern Mariana Islands in their actual location – you 
can zoom in to just the contiguous U.S. or to include Alaska and Hawaii.) 

 
 

https://www.census.gov/geo/maps-data/data/tiger-line.html
https://www.census.gov/geo/maps-data/data/tiger-line.html


 

 

 

 
 
 
 
 

3. Go to the FBI’s Uniform Crime Reports website: 
http://www.fbi.gov/about- us/cjis/ucr/ucr 

 

4. Under Crime in the United States, go to the link for the new online 
UCR Data Tool: www.ucrdatatool.gov 

 

5. Under Find Data, click on “Go to the table-building tool” 
 
6. We will build a table that contains some crime data for all the U.S. states, 

because that is the equivalent shapefile we have and would like to join this 
data to. We want a table with one row of numerical information for each 
state so it will easily join with our attribute table for U.S. states, which also 
has one row per state. This will be a one-to- one join. 

 
• Click on All States and U.S. Total 

 
• Click on One year of data 

 
• Select all of the states by clicking on Alabama, then scrolling down 

to the end of the list, holding down the shift key, and clicking on 
Wyoming. 

 
 

http://www.fbi.gov/about-us/cjis/ucr/ucr
http://www.ucrdatatool.gov/


 

 

• Choose a variable group – we will use “Number of violent crimes” 
 

• Choose a year (for example, 2009 because our shapefile dates to that time) 
 

• Click the “Get Table” button 
 

7. Download the resulting table. 
 

• Click on the “Spreadsheet of this table” link near the top of the page (.csv 
file) When prompted, use Microsoft Excel to open this comma-separated 
table. 

 

 

 



 

8. This table now needs to be cleaned up a bit so that ArcGIS can read it easily. We 
don’t need the information in the first six rows – we want the first row (which 
will become the header row in an ArcGIS attribute table) to be the one telling us 
what the fields are— what is currently Row 6 in this table. We also need the 
field names not to have any spaces, so we will edit cells in what is now Row 7 to 
remove spaces from field names (or replace spaces with underscores). The final 
thing we’ll do is take away the descriptive information at the bottom of the 
table. The row for Wyoming should be the end of the table. 

 

9. Save your cleaned-up crime table to the DATA folder in the DOWNLOADS folder. 
 

10. Add the two files you’ve downloaded to the map from the DATA 
folder in the DOWNLOADS folder. 

 
11. Right click on the states shapefile and choose Join. Join the shapefile to the 

spreadsheet using state names as the common field (this is the NAME field in 
the states shapefile). See pp. 15-16 for a reminder on joining if needed. 

 
12. Check the attribute table of the states shapefile to see if the join worked. You 

should be able to see the homicide data appended to the attribute table. You 
may have null values where data is missing, such as for the U.S. territories – that 
is fine. We selected “keep all records” when making the join – if we had selected 
“Keep only matching records,” the territories would have been eliminated.

 
 
 
 

13. Make a color map of aggravated assault for all states. 
Hint: Right click states shapefile – Properties – Symbology tab – Quantities 

 
 



 

14. Here’s the end map! 
 

 
 
 



 

 
 
 
Census Exercise – Cheat Sheet 

1. Download a shapefile containing all U.S. States – follow steps 1-5 as seen on 
pp. 24-25 of this workbook. 

 
2. Look at the attribute table of your U.S. States shapefile. When you’re looking 

for census data, you will need to keep in mind that it will have to have a 
common field in order to be able to be joined to this shapefile. It looks like the 
state name field will be the easiest one to use for a join. 

 
3. Go the U.S. Census American Factfinder webpage: http://factfinder2.census.gov 
4. Go to the Advanced Search and click “Show Me All”. We want to download some 

data for the entire U.S. by state, so we’ll click on the “Geographies” tab, and 
use the “Select a geographic type” drop-down menu to choose “State” and 
“All States within United States” and click on “Add to Your Selections”. Close 
the “Select Geographies pop-up box. 

 

 
 

http://factfinder2.census.gov/


 

 
5. Next we’ll click on the sideways-facing arrow in the “Topics” tab to expand the 

category and see some options for data. Click on the plus sign to expand the 
“Dataset” group, then click on “2011 ACS 5-year estimates”. Close the “Select 
Topics” pop-up box. We now have over 1,000 tables to consider. Let’s use the 
“Refine your search results” box to search for “housing”. Click on Table S2504, 
Physical Housing Characteristics for Occupied Housing Units. 

 
 

6. This is a nice- 
looking table with lots of good data, but will it match the attribute table for U.S. 
states that we have? We do have fields for each state name, but in this table they 
are the columns, while in the U.S. state shapefile, the state names are the rows. 
They will need to match. Luckily, you can modify this table. Click on “Modify Table” 
and then on “Transpose Rows/Columns”. We want the state names to be vertical 
on the left, not horizontal along the top of the table. This is how it should look: 

 
 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. N
ow we are ready to download the table. Click on the “Download” link at the 
top and choose the “Data and annotations in a single file” option under the 
Comma delimited format. This is usually a cleaner, better option than 
choosing to download a Microsoft Excel table. Also, there are size limitations 
on Excel table downloads. 

 

 
 
 

8. Choose to open the zipped file with Windows Explorer, then extract the 
files to the DATA folder in your DOWNLOADS folder. 

 



 

 
 



 

9. Open the ACS_11_5YR_S2504_with_ann file. The first row will be the field 
names in the attribute table in the GIS. That is fine here, but the field 
names are not obvious 

identifiers – you would need to look at the DEC_10_SF1_P12_metadata file to 
know what these codes are indicating. 

 

 
 

10. Open up ArcMap and a new, blank map. 
11. Add the two files you’ve downloaded to the map from the GIS_WORKSHP 

folder in the DOWNLOADS folder. 
 
 

 
 
 

12. Look at both attribute tables to see what field you will use to make the join 
and what it is called in each table. Right click on the states shapefile and 
choose Join. Join the shapefile to the spreadsheet using state names as the 
common field (NAME from the states shapefile and GEO.display-label from the 
census table). See pp. 15-16 for a reminder on joining if needed. 



 

13. Check the attribute table of the states shapefile to see if the join worked. You 
should be able to see the census data appended to the attribute table. You may 
have null values 

where data is missing, such as for the U.S. territories – that is fine. You can 
choose “Keep only matching records” when you make the join if you want to 
avoid this. 

 

 
14. Make a color map with the new housing data from the census. 

Hint: Right click states shapefile – Properties – Symbology tab – Quantities 
Remember: You will look at the metadata to decide which field to use (for 
example, HC01_EST_VC01 will map estimated occupied housing units) 

 
15. Here’s the end map! 

 

 
 
 



 

Food Atlas Exercise – Cheat Sheet 

1. Go to the following link to download a shapefile with boundaries for all U.S. 
counties: https://www.census.gov/geo/maps-data/data/tiger-line.html (go to the 
2013 TIGER/Line shapefiles main page, then click on “Download”, Select a 
layer type Counties and equivalent. 

 
2. Click on 2012 TIGER/Line Shapefiles Main page, then click on “Download 

Shapefiles”. Check off the box for “Counties (and equivalent)” and click on 
“Submit” and then “Download national file”. 

 
3. Open the zipped file with Windows Explorer and then extract all the 

files to the DATA folder in your DOWNLOADS folder. 
 

 

4. Next we will download a table in spreadsheet form from the Food 
Environment Atlas: http://www.ers.usda.gov/data-products/food-
environment-atlas.aspx 

 

5. Click on the “Data Access and Documentation Downloads” link, then download 
and save the current version of the “Food Environment Atlas Data File” 
spreadsheet to the DATA folder in your DOWNLOADS folder. 

 
6. Investigate the Food Atlas spreadsheet. There are multiple worksheets with 

different kinds of data. How do you know what the field names indicate? You 
need to look at the Variable_List worksheet to find the metadata. 

 
7. Open ArcMap and add both the new counties shapefile and one of the 

worksheets from the Food Atlas spreadsheet that contains data you are 
interested in. 

 
 

https://www.census.gov/geo/maps-data/data/tiger-line.html
http://www.ers.usda.gov/data-products/food-environment-atlas.aspx
http://www.ers.usda.gov/data-products/food-environment-atlas.aspx


 

 
 
 

8. Take a look at the attribute tables of both layers. How will we be able to join 
them? County name is an obvious possibility, but try sorting the counties 
alphabetically and seeing how many Washington Counties there are in the 
U.S. It will be easier if we can make a one-to-one relationship for our join. For 
that reason, we’ll use a FIPS field. 

 
• The counties shapefile has three fields with FIPS numbers (STATEFP, 

COUNTYFP, and GEOID), but the Food Atlas table has only one FIPS 
field, with a five-digit number. Therefore, we’ll make the join using the 
GEOID field from one and the FIPS field from the other. 

 
9. Right click on counties, and choose Joins and Relates > Join 

 
 



 

 
 

10. Take a look at the attribute table of counties to see if the join worked. The food 
data should be added on to the end, so that the last field is FOOD_TAX11. 

 
11. Now we’ll map this new information. Right click on counties and choose 

Properties > Symbology tab. Choose Quantities, then pick a field from the food 
data to map. For example, this map used the PRICES_TAXES worksheet from the 
Food Atlas data and shows the price of milk in all U.S. counties. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 

More Training and Information 
University of Maryland at College Park students, faculty, and staff have access to free 
online courses provided by ESRI. These cover a wide range of GIS topics and skills. To 
gain access to online classes, please contact kelleyo@umd.edu with the name of the 
course you are interested in and your UMD e-mail address to obtain a registration 
code. 

 
Course list: https://www.esri.com/training/unlimited-esri-training/ 

 

University of Maryland Libraries’ GIS and Spatial Data Services Center 
website: http://lib.umd.edu/gis/ 

 

University of Maryland Libraries’ GIS and Spatial Data Services Center 
workshop series: https://www.lib.umd.edu/gis/workshops 

mailto:kelleyo@umd.edu
https://www.esri.com/training/unlimited-esri-training/
http://lib.umd.edu/gis/
https://www.lib.umd.edu/gis/workshops
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